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How Export Style Sheets Work
An Export Style Sheet is the tool that shows CatBase exactly what information

you want to publish, how you want your data formatted, how it should be sorted,
whether you want to index any data item (e.g., product names), and so on. You
can set up as many Export Style Sheets as you need: each one will be designed
to publish your data in a certain way.

Through the Export Style Sheet you tell CatBase:
• What the default publishing destination for that style sheet is (e.g.,

QuarkXPress, PageMaker, HTML documents, etc.)
• How you want the data organised into paragraphs
• Which Style Sheet to apply to each paragraph
• What comprises each Paragraph
• Different text formatting within the Paragraph, if appropriate
• How to handle blank paragraphs
• How to sort the records

Once you have designed an Export Style Sheet, the steps for producing your
publication are:

1. Find the records you want to include in the publication
2 Tell CatBase which Export Style Sheet to use
3. Choose a publishing destination
4. Export the data. This creates a text file that contains the data plus the for-

matting information.
Then ...
If your publishing destination is a page layout program:
1. Open up your publication template in your page layout program
2. Import the text file you just created from CatBase
3. Proof, add graphics if necessary, and print!

If your publishing destination is HTML documents:
1. View the HTML documents in a browser

If your publishing destination is a text file:
1. Open up the text file using a word processor, spreadsheet, or other suit-

able program.

This chapter is intended as a reference to the Export Style Sheets. You should
work through the Demo first to get an overview of how they work, and then refer
to this section when you need more detailed information.

CatBase can create Export Style Sheets for publishing data in the following
formats: 

QuarkXPress 
PageMaker
Multi-Ad Creator2
HTML
RTF (Rich Text Format)
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Delimited Text Files

The RTF format is very useful as it is supported by many page layout and
word processing programs, such as Microsoft Word, PageMaker, Page Plus, and
numerous others.  

Style Sheets
If you have worked with a word processing or page layout program, you will

probably have used style sheets. You specify formatting information such as the
font, style, and size to be applied to the text in a paragraph, give the style sheet a
name, and then specify which paragraphs in the document should have that style
sheet applied to them.

You set up paragraph style sheets (not to be confused with Export Style
Sheets) in CatBase, and you will specify one style sheet to be applied to each
paragraph that you set up in an Export Style Sheet. You will also be able to speci-
fy different formatting for elements within a paragraph.

Creating a Style Sheet
When the data is exported to a page layout program, each paragraph has the

designated style sheet applied to it. You may then, if necessary, make global for-
matting changes after the data has been placed in the document.

To create a Style Sheet:
➢ At the main CatBase screen, choose Style Sheets from the Data menu, or

click on  the Exporting button on the Options palette, and then on the
Export Styles button.

➢ Click on New Record at the Search dialogue.
A new Style Sheet record opens up:
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Different publishing destinations support different style sheet options, so
there are four pages on the Style Sheet screen for the various formats. A style
sheet can be used for more than one publishing destination, so you might use
more than one of these pages. For example, perhaps you want to create a price
list for publication in print using QuarkXPress, and also for publication as an
HTML document to go on your web site. In that case you would create a style
sheet named Price List (for example), and set up both the XPress and the HTML
pages.

XPress
Set up this page if your publication destination is QuarkXPress.

HTML
Set up this page to publish your data as an HTML document or documents.

PM 6.5+
Use this page to set up for publication using PageMaker version 6.5 or later.

Note: You can also use the RTF format with all versions of PageMaker.

PM 6.5-/RTF
Use this page to set up for publication with versions of PageMaker prior to

6.5 or as RTF files.

Delimited Text Files
You may have noticed that there is no option for delimited text files on the

Style Sheet screen. That’s because text files are simply plain, unformatted text,
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and they do not use style sheets.

Unit of Measurement
The unit of measurement used in your style sheets depends upon what is

selected in the Setup screen (please refer to Chapter Two, Setting up your
Database, if you need more information). In the examples shown here, we are
using centimetres. 

➢ Click on the appropriate tab for the intended page layout destination
✏ Type a name for the style sheet. NOTE that style sheet names cannot con-

tain any spaces. They may be up to 20 characters in length.

Some options (Character Formats, Tabs, and Rules) are common to most of
the publishing destinations, so they are described together here. The other for-
matting options (font, size, indents, etc.) work as they do in your page layout pro-
gram.

Character Formats
The Character Formats area shows a list of character formatting options:

To select one or more formats, double-click on its line. A tick will appear in the
Use column for that item. For example, to underline the text:

To un-select a line, double-click on that line again.
Note: For best results in your publication, we recommend that instead of using

the Bold or Italic styles, you select a Bold or Italic version of the font.
You can select any number of character formats.
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Tabs
To set up Tab stops, click on the Tabs button. A floating palette will appear:

To add a Tab, click on the Add a tab button. A line is added to the list of
tabs:

➢ Click in the Location cell and type in the location for this tab. 
➢ Choose a different alignment from the pop-up menu in the Align column if

necessary.
➢ The “On” column is for use only with QuarkXPress. You can type a charac-

ter for the text to be aligned on into this cell (please see your XPress documenta-
tion for details on how this works).

➢ If you want to  fill the tab with a leader (for example, dots or dashes), click
in the Leader column and type in the character you want to use.

For example, the following tab has been set to 5 cm, aligned right, with a dot
for the fill character:

You can add any number of Tabs. They will be sorted by Location.

When you have finished setting up your Tabs, close the Tabs window by click-
ing its close box.

When one or more Tabs have been set up for a Style Sheet, the Tabs button
will display a plus sign.

Deleting Tabs
To delete a tab stop, click on its line in the Tabs window and then click on the

Delete Tab button.

Rules
Click on the Rules button to create rules above or below the paragraph. A
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floating window will appear:

You can have a rule above or below the paragraph, or both.
To set a rule above the paragraph, click on the Rule Above check box.
The Length pop-up menu offers two choices: Indents and Text. If you choose

Indents, the rule will be drawn the same width as the paragraph, allowing for the
left and right indents that are set up in the Style Sheet screen. If you choose Text,
the rule will be drawn the same length as the first line of text in the paragraph.

From Left determines the distance between the left end of a rule and the left
indent or the left end of a line of text, depending upon the selection made in the
Length pop-up menu. The figure that you enter in the From Left or From Right
fields is displayed in the selected unit of measurement.

From Right determines the distance between the right end of a rule and the
right indent or the right end of a line of text, depending upon the selection made
in the Length pop-up menu.

Positive values make a rule shorter. You can enter negative values to make a
rule longer.

Offset is used to specify the vertical distance between a paragraph and the
rule above it (or below, for Rule Below). You can enter an absolute value or a per-
cent value. Absolute values are measured from the baseline of the first line of text
in a paragraph to the bottom of the rule above. You can enter a positive value up
to 15” or a negative value up to half the width of the rule. You can position a rule
to .001 unit of any measurement system. A rule placed with an absolute offset
can be positioned so that it overlaps one or more lines of text in a paragraph. You
can create reversed type that flows with text by specifying a dark rule in combi-
nation with light text.

Percent values are based on the vertical distance between the ascent of the
first line of text in a paragraph and the descent of the preceding paragraph. The
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total distance between paragraphs is 100%. A 30% offset value, for example,
places a rule with 30% of the total interparagraph space below the centre of the
rule and 70% of the interparagraph space above the centre of the rule. You can
enter offset values from 0% to 100% in .1% increments.

Rule Styles
When you click on the Style area, a picture menu pops up. For QuarkXPress

you have the following options:

For PageMaker the options are:

➢ Select the style of your choice. 

Rule Width
The Width field lets you specify how wide (or thick) the rule will be in points.

You can enter any width. To create a hairline rule, enter .25. It will be printed as
.25 pt  on a high-resolution printer, such as a phototypesetter, and as .5 pt on a
laser printer.

Rule Colour
Choose a colour for the rule by clicking on the pop-up Colour menu. The

colours available are the ones you have set up in the Colours design screen
(under the Data menu).
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If a Rule has been specified for a Style sheet, the Rules button displays a
plus sign.

Text Box
If your page layout program is QuarkXPress, you can create anchored or

unanchored text boxes into which you can put whatever information you want
from your database. The text box can have a border, so this can be a handy way
to create semi-display advertisements and that sort of thing.

When you create a text box for an XPress style sheet, any text formatted with
that style sheet will be placed within the text box. There are a couple of require-
ments:

1. You need to have a copy of the Xtags Xtension installed in your Quark
Xtension folder.

2. For anchored text boxes, the box must be no wider than the width of the
column into which it will flow.

To create a text box, click on the Text Box button. You will then see a dialogue
box like this:

Most of the options within this dialogue box work in the same way as in
XPress – see your XPress manual for a detailed description. However there is one
additional (and very useful) option:

Shrink to Fit
If you select this check box, when the text is flowed into your Quark layout the

text box will, initially, be drawn at the height indicated in the Height setting. But
once all the text has been flowed into the box, the height of the box will automat-
ically shrink so that it is just the right height for the text. You should set the
Height to the maximum size that you think will be needed. 
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Warning! If it is an Anchored text box, don’t make the text box height greater
than the height of the column into which it will go, or you will have problems
when you try to import it into the XPress layout (you’ll soon know that you have a
problem …). 

Anchored/Unanchored Text Boxes
An anchored text box is anchored to the text which surrounds it, so that if the

layout changes, the box flows along with the text and always stays in the same
relative position. An unanchored text box is placed on the page within the text
flow when the text is imported into the XPress layout, but it is not anchored to
the surrounding text. If the layout changes, the text box will not move; it remains
stuck on the layout in the place where it originally landed unless you move it
manually. 

An anchored box must fit within the column; in fact it must be slightly narrow-
er and shorter than the column, whereas an unanchored box can be any size that
will fit on the page.

An anchored box cannot contain other text or picture boxes, whereas an
unanchored box can.

Note: When you click on the Text Box button, a text box specification is creat-
ed if one does not already exist for that Style Sheet. 

To delete a text box, click on the Delete the Text Box button.

Exporting and Importing Style Sheets
You might want to copy a Style Sheet that you have designed in one data file

for use in another. To facilitate this, you can export and import Style Sheets. To
do this:

➢ Find the Style Sheet or Sheets you want to transfer out of the data file.
➢ Choose Export … from the File menu.
✏ Enter a name for the file that will be created and click on Save.
The Style Sheet information is exported.
➢ Switch to the data file into which you want to import the Style Sheets.
➢ Choose Style Sheets … from the Data menu.
➢ Click on the Import button in the Search Dialogue.
➢ Locate the file you just exported and double-click on it.
The Style Sheets are imported. If there is already a Style Sheet in the data-

base having the same name as one you are importing, the name of the imported
Style Sheet will have a number appended to it.

Note: Style Sheets can only be transferred between databases that have been
used with the same version of CatBase. If you need to transfer one from an older
version (for example, perhaps you want to copy one from the Demo Data file),
you should follow the following procedure:

1. If you want to still be able to use the data file with an older version of
CatBase, make  a copy of the data file and use the copy.



2. Open up the data file using the current version of CatBase. It will be
updated to the current version.

3. Export the Style sheets and import them into the other data file as
described above.

Important Note: You cannot transfer style sheets from a data file that has not
been updated to Version 4. Please contact CatBase Software if you need to do
this.

If you just want to make copies of a Style Sheet within a data file, use the
Duplicate selection under the Modify menu.
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Export Style Sheets

Export Style Sheets are the heart of the CatBase system. They are the tool
you use to specify what will comprise your publication, and how it will be format-
ted.

Before you begin, you must carefully and thoughtfully spec out your publica-
tion. This will make the process of designing the Export Style Sheets much easi-
er. You need to know:

• From which table or tables you want to export data
• What data you want to publish from each record
• How you want that data organised into paragraphs
• What formatting you want to apply to each paragraph
• How you want the data sorted

Which tables you can export data from
You can export data from the following tables:

• Companies
• Products
• Company Contacts
• Product Details
• Categories

(Some of these tables may have different names in your database.)
Each Export Style Sheet is based on either Companies, Products, or

Categories. In addition to exporting data from the base table, you will also be
able to include data from related tables. For example, if your Export Style Sheet
is based on Companies, you will be able to include the related Product, Contact,
and Category information that belongs to each Company.  

In the Demo database you will find an example Export Style Sheet named
Four-Table Example. This export illustrates how data can be exported from four
related tables. It is based on the Companies table, and data is looked up from the
Products, Contacts and Categories  tables. It produces text like this:
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The Companies are sorted alphabetically,  and for each Company, CatBase
has found all of its Products, Contacts, and Categories and listed them.

The following illustration shows all possible relationships between the tables:

As you can see, there are three levels for relating data. In the Four-Table
Example shown above, the three “1st. Relation” tables that are related to the
Companies table are used. If the Export Style Sheet was based on Contacts, you
would be able to include information from the following tables:



1. Companies: for example, you could include the company’s address and
phone number.

2. Company Categories: include a list of all Categories that the Company has
been placed in.

3. Products: You could then include a list of the Company’s products.
4. Product details: For each of the Company’s products, you could list any

Product Detail records that belonged to it.
4. Product Categories: For each of the Company’s products, you could

include a list of the Categories they have been placed in.

Of course, it’s quite likely that you will export information from only one table
(e.g., Companies or Products). 

If the Export Style Sheet is based on Categories, it is effectively based on
either the Products or the Companies file. The difference is that  the records will
be grouped by Category. 

How Export Style Sheets are Designed
Creating an Export Style Sheet consists of the following steps:
1. Create a new Export Style Sheet and select the table on which it will be

based (Companies, Products, Contacts or Categories).
2. Create one or more Paragraphs. Each Paragraph will be used once for

each record.
3. Add one or more Elements to each Paragraph. Elements are the building

blocks that you use to tell CatBase exactly what information you want to
publish. There are seven Element types, and they are described next. 

Element Types

• Field: The contents of a field from the selected table
• Text: Some text that you specify (e.g., the word “Tel: “, or a heading.
• Formula: Lets you tell CatBase how to choose what data to include,

and/or how to format it.
• Punctuation: e.g., a Tab character
• Calculation: e.g., markup or discount a price
• Picture: Include a picture
• Relation: Gather data from a related table

The element types are described in detail later on in this chapter.

Creating an Export Style Sheet
Please note: If you are unsure about any aspect of setting up your Export

Style Sheets, please get in touch with us – we will be happy to help you. You can
send an email to support@catbase.com, telephone us on 0700 CATBASE or send
us a fax. 

To set up an Export Style sheet:
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➢ Choose Export Style Sheets … from the Data menu at the main CatBase
screen.

➢ Click on the New Record button at the Search Dialogue.
The following dialogue box appears:

An Export Style Sheet must be based on either the Companies, Contacts, or
the Products table. The Categories radio button options base their Export Style
Sheets on the Products or Companies file, but the records are organised accord-
ing to the Category hierarchy that you set up. Your choice here will depend upon
the type of information you want to export and how you want it sorted. 

If you want to export mainly Company information, and you want to sort the
information by company name (or by any other field in the Companies file except
Category) choose the Companies radio button. Keep in mind that you will be
able to include information on Contacts, Categories, and Products related to
each company by use of the Relation Element type.  If you want to export mainly
Company information but you want to sort the records by Category, choose the
Companies Categories radio button.

If you want to export Product information, and perhaps include some data
from the Companies file, choose the Products radio button. However, if you want
to sort the product information by category, use the Product Categories option.

If you want to export information on Company Contacts, choose the Contacts
radio button. You will be able to sort the records by any field in the Contacts
table (such as Last Name or Title), and you will be able to include information
from each contact’s Company (such as their phone or fax number) by using a
Relation to the Companies file.

When you base an Export Style Sheet on either Product or Company
Categories, CatBase will automatically insert the appropriate category headings
for you as the data is exported. All you need to tell CatBase is which Paragraph
Style Sheet to apply to each Category level. You DO NOT need to include an
Element for the Category name in your Export Style Sheet.

If you are unsure on which file your Export Style Sheet should be based, think
about how you want the data sorted. You’ll base the Export Style Sheet on the
table that contains the sort field. Here are some examples:
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To sort by Base the Export Style Sheet on
Company Name Companies
Product Name Products
Company data, sorted by category 

name or number Company Categories
Product data, sorted by category 

name or number Product Categories
Contact name Contacts
Contact title Contacts

We will use the Product Categories option as an example.
➢ Click on the Product Categories radio button and then on OK.
A new Export Style Sheet appears:

Each part of the screen is described below.

Export Style Sheet Name
You must name each Export Style Sheet. Each name must be unique, and can

consist of up to 35 alphanumeric characters.

Base Table
This is the table on which the Export Style Sheet is based. You cannot change

this; however, you can move the Export Style Sheet to another base table by



clicking on the big button at the bottom of the screen.

Creation Date
The date on which this Export Style Sheet was created. Not modifiable.

By:
The user name of the person who created this Export Style Sheet. Not modifi-

able.
Description

You can type a brief description here.
Paragraphs

This area will show a list of the Paragraphs you create.
Add a Paragraph

You click on this button to add a new Paragraph.
Delete Selected Paragraph

You click on this button to delete a Paragraph.
Default Export Format for this Export Style Sheet

When you create a new Export Style Sheet, your default Export Format (as
specified in the Setup screen) is selected. However, you can choose a different
Export Format for any Export Style Sheet. Perhaps your default format is
QuarkXPress, but you want to set up a special Export Style Sheet to create HTML
documents. You would choose HTML from the pop-up menu.
Move this Export Style Sheet to a different Base Table

Once an Export Style Sheet has been created for a certain base table, it can
be moved to certain other base tables if necessary. The following chart shows
you which moves are possible:

Original Base Table Can be moved to
Companies Company Categories
Company Categories Companies
Products Product Categories
Product Categories Products

Click on the big button to move to a different base table.

Preferences 1
Click on the Preferences 1 tab to go to the first of two Preferences pages:
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General Preferences

Sort Order
CatBase needs to know how you want your information sorted. You can cre-

ate Sorts and save them so that they can be used again. 
Note: If your Export Style Sheet is based on Categories (as this example is),

the Sort Order that you specify here will be used to sort the Company or Product
records within their Categories.

If you have already created some Sorts, choose one from the pop-up menu.
Otherwise:

➢ Click on the New Sort button. The Sort Editor window appears:
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The Sort Editor is described in detail in Chapter 4.
Create a Sort and save it by clicking on the Save button; then click on OK.
The Sort you just created will be selected in the pop-up menu.

Blank line after each record
If you want CatBase to insert a blank line after each record is exported, check

this box. 

Include records marked for deletion
Normally, CatBase will skip over any records that have been marked for dele-

tion when it is exporting data. If you want such records included, check this box.

Include inactive records
Normally, CatBase will skip over any records that have been marked as

Inactive when it is exporting data. If you want such records included, check this
box.

Text Conversion
CatBase is a cross-platform application; it runs on both Windows and

Macintosh systems. Most of the time this makes little or no difference to the  way
you use the program. However, there are some differences in the way the two
operating systems handle special text characters and if you are going to be
transferring data between platforms, you should be aware of this. For example, if
you are working on a Windows PC  and you are going to export data that will be
used in a page layout program by one of your associates working on a
Macintosh, the text should be converted to the Macintosh format when it is
exported. If it isn’t converted, some special characters may appear as something
completely different on the Mac. In that event you should select PC to Mac from
the Text Conversion pop-up. Conversely, if you are exporting data on a Mac to be
used on a Windows PC, you should choose Windows to Mac from the Text
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Conversion pop-up.
Note that you only need to be concerned with text conversion when you are

importing or exporting data to or from the database. If you are using CatBase
Multi-User on a mixed network, the text conversion is handled automatically by
the server engine, so that special characters are always displayed correctly on
different workstations.

Format Booleans as Yes/N or 1/0
Boolean fields are always in one of two states: True or False, or On or Off,

however you choose to look at it. This option lets you choose how to format
Boolean data when it is exported.

If you want more control over the formatting of Boolean data, you can use a
Formula to do this. Formulas are described a little later in this chapter.

PageMaker 6.5 or Later

Location of Pictures folder
PageMaker V. 6.5 or later can handle the automatic placement of pictures. In

order for this work, you must tell CatBase where the folder containing the pic-
tures is located. You can type the precise location of the folder into this field, or
(easier!) click on the Select button to choose it. 

The picture folder location must be a complete pathname to the folder. For
example:

In this example, the Pictures folder is within a folder called CatBase V4, which
is  in a folder called CatBase Development, which is on the hard disk called
PBHD. The Pictures folder doesn’t have to be called Pictures; call it whatever you
like. If the correct pathname is not specified, you’ll get an error message when
you import the file into your PageMaker layout.

Text Exports
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In this area you will find options for setting up an export for exporting to a
delimited text file. A delimited text file is a file containing plain, unformatted text,
in which each record is delimited with a standard character (usually a Return
character), and each field is delimited with a certain character (usually, either a
Tab or a comma) -- unless it is fixed-length, in which case the fields are not
delimited but they are all padded with spaces (or zeros for numeric fields) so that
every record is exactly the same length. 

This type of file can be very useful if you want to transfer data from CatBase
to another application, such as a spreadsheet, or in a format that can used in a
mailmerge. 
Field Delimiter

The choices for Field Delimiter are:

Replace embedded Return characters with:
If you are exporting text from Large Text fields, and if your Record Delimiter is

a Return character, you’ll have a problem when you import the file into another
application because wherever a Return character appears within a Text field, the
program will think that’s the end of the record. To combat this problem, you can
either choose a different record delimiter (as described above), or you can tell
CatBase to replace each occurrence of a Return character within a Large Text
field with some other character. Choose a character that isn’t going to appear
within your text! For example, you could use a tilde (~) character. Then, once the
data has been imported into the other application, you could replace all the tildes
with a Return. This is a less efficient option than changing the record delimiter
and is really only recommended if the other application does not let you select an
alternative record delimiter.
List Field Names in First Line

In some instances it will be useful to have a list of the field names at the
beginning of the export file (for example, if you are going to import it into a
spreadsheet). Click in the List Field Names in First Line check box to make this
happen. The first “record” in the export file will be a list of the field names, delim-
ited in the same way as the rest of the file.

Fixed-Length Text Export
If you choose Fixed-Length, the Text Exports area changes:

Description
Each field is separated by a Tab (ASCII 9)

character.
Each field is separated by a three-character

string: “,”
Each field is exactly the same length in

every record. If the contents of the field do not
fill it, it is padded with spaces or zeros to make
it the correct length.

Delimiter
Tab

Comma

Fixed-Length
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Maximum length of Text fields
A Text field (such as the Notes or Description fields) can contain up to 32,000

characters, so if you include a Large Text field in a Fixed-Length export you could
end up with an enormous export file because, since each occurrence of a field
must be the same length in a fixed-length export, each record would contain
32,000 characters for each text field. To control this, you can specify the maxi-
mum length. The default is 256 characters; you will probably have an idea of what
the maximum amount of text in any Text fields you are going to include will be.

No. of characters for Numeric Fields
Numeric fields must be padded with zeros to make them all a uniform length.

The default length is 10 characters, but if you know that your data includes some
particularly big numbers, you should increase the size of this field accordingly.

Record Delimiter
The choices for Record Delimiter are:

Description
Each record is delimited by a Return char-

acter. This is the usual record delimiter.
Each record is separated by a Tab (ASCII 9)

character. Make sure that you don’t also select
Tab as the field delimiter! Also make sure that
the application into which you are going to
import the file can handle a Tab as the record
delimiter.

Each record is delimited by a Line Feed
character. Make sure that the application into
which you are going to import the data can
handle a Line Feed as the record delimiter. This
option can be useful if you are exporting data
which contains Large Text fields, as this type of
field can contain Return characters. (See the
note re. embedded Return characters, below).

Delimiter
Return

Tab

Line Feed
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Preferences 2

HTML Exports

In this area you will find options for setting up an export to HTML documents.
Page Title

Type in the title that you want to appear in the window’s title bar when the
document is opened up.
Edit Header/Footer

You can type in some text to appear at the top and/or bottom of each HTML
page. To do this, click on the Edit Header/Footer button. An editing screen
will appear, with two areas – one for the Header and one for the Footer.

You can include HTML tags in the text areas. We have included a basic list of
HTML tags in Appendix F, with some examples and ideas for including graphics
in your headers and footers, formatting text, and adding links. For more detailed
information about HTML, there are many reference books available.
Page Background Colour

You can select either a plain colour or a picture for the background to your
HTML documents. The choice of colours depends upon the colours you have
created (please refer to Chapter 2, Setting up your Database, for information on
how to define colours).
Use Background Picture

Select this radio button if you want your HTML documents to have a picture
background instead of a plain colour. Then click on the Choose button to select
the picture you want to use. Note that the picture must be within a folder which,
in turn, must be within the same folder as the HTML documents.

Tables
If you want your data to appear as a table in your HTML documents, select

the Treat Tabbed Text as Table check box. The Tables area changes:
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In order for data to be formatted as a table, it is essential that you have AT
LEAST one Element that is a Tab in the Export Style Sheet (Element types are
described below). CatBase will count the number of Tabs in the Export Style
Sheet and create a table with that number of columns.
Border Width (pixels)

This is the width of the border that will drawn around the table. You can speci-
fy 0 if you don’t want a border.
Cell Padding (pixels)

This is the amount of space around the edges of the information in the cells
Cell Spacing (pixels)

The amount of space between table borders and table cells.
Alignment within cells (horizontally)

This determines the way that the text is aligned within the cells. The choices
are Left, Center, Right, Justify, Char. The Char selection lets you specify a charac-
ter to align the text on – for example, you would select a dot to align numeric
data on the decimal point. If you choose Char, the display changes a little:

Type the alignment character into the On character field. The default is the
dot.

Note: If the alignment character is a dot, this will be applied only to cells con-
taining numeric data; all other cells will be aligned left. 
Alignment within cells (vertically)

This option lets you choose how the text should be vertically aligned within
the cells. The choices are: Top, Middle, Bottom, and Baseline.

Max. Number of records per page
This figure determines how many records will appear on each HTML page.

When the records are exported, CatBase will create as many documents as are
needed to contain all the records, and it will add links to the bottom of the page
(please see the example which follows).

As an example of an HTML export, consider the following settings:
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The Header and Footer have been set up like this:

This is what you get when the data is exported to HTML using  this Export
Style Sheet:
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The Page Title is Current Product Catalogue:

The Header appears at the top of each page:

The incredible background colours are courtesy of the picture,
SampleBGPicture.jpeg.

There are four columns in the table.

The bottom of the page looks like this:

The footer (“These pages were built by CatBase”) appears below the last
product on the page.
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Since the Export Style sheet specifies that there should be no more than five
records per page, and we exported 33 records, the export has been split up into
seven HTML documents (pages), and links to these documents have been added
to the bottom of the page.

If you would like to see how this Export Style Sheet is set up, it’s the Product
Catalogue for Web2 example in the Demo Database.

Category Settings
The final tab on the Export Style Sheet screen is the Category Settings (note:

this tab is visible only if the Export Style Sheet is based on Company or Product
Categories):

Sort Categories by:
The default sort order for Category exports is by Category Name.
Click on the Number radio button if you would rather have them sorted

numerically.
Main Category only/All Categories

When you assign Categories to Company or Product records, you can specify
a Main Category for each record (in fact, the first Category that you add for each
Company or Product record is always the Main Category, and you MUST have
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one Category specified as the Main Category). When CatBase is exporting
records by Category, it will search for either:

• ALL Company or Product records that have been assigned to the
Category being exported, or

• Company or Product records for which the current Category has been
assigned as the Main Category,

depending upon which of these radio buttons is selected:

Here is an example of how this might be used.
You publish one general catalogue each year, in which every product is listed,

and a number of specialty catalogues such as Spring, Winter, Christmas, etc.
Each product is assigned to one general category, and additionally may be
assigned to any number of specialty categories. You would make the general cat-
egory the Main Category, and add as many additional Categories as you need for
each product.  When you create the Export Style Sheet for your general cata-
logue, you would choose the Main category only radio button. However, when
you create the Export Style Sheets for the specialty catalogues, you would
choose the All categories radio button and then export the appropriate category.

Group all Subcategory entries under one main category heading
You may want to have a list of all records that are under each main (Level One)

Category heading, even if they are assigned to Level Two or Level Three cate-
gories. Select this check box and CatBase will do this for you. For example, in
our Demo database we have two Level One categories: Hardware and Software.
By selecting this check box, we could easily create a list of all  hardware prod-
ucts and all software products, regardless of their sub-categories.
Include categories that have no entries listed under them

Is it possible that there will be categories in your data file to which no
Company or Product records have been assigned? If this is so, you can choose
whether you want CatBase to include the names of those Categories when it is
exporting data.

If this check box is left unchecked, CatBase will ignore any categories to
which no records have been assigned. If the box is checked, every category
name will be included even if there are no records belonging to it. However, if
there are no records belonging to a Level One category but there ARE records
belonging to that category‘s Level Two or Level Threes, the Level One category
name will be exported regardless of whether the box is checked or not. 
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Category Headings

There are three choices for printing the Category headings:
• Print the name of each Category, styled according to the selected style

sheet for each level.
• Use a picture for each category heading
• Don’t print the headings at all.

Print Category Names
This is the default setting. You must choose a style sheet for each Category

level. When the records are exported, the category name will appear at the begin-
ning of each group of records under that category, formatted as specified in the
selected style sheet.

Style Sheets for Category Headings
You need to tell CatBase how to format the category names.
➢ Click on the pop-up Style Sheet menu to select a Style Sheet for each of

the Category levels.
You can create a new Style Sheet by clicking on the New Stylesheet but-

ton.

You can create interesting Category headings by setting up Style Sheets that
have text boxes associated with them (QuarkXPress users only; requires the
XTags Xtension).

Use Pictures
If this option is selected, the display changes:



Instead of selecting a style sheet for each Category level, you must specify
the formatting of the picture box. To do this, click on the appropriate Picture
Setup button. The Picture Setup screen is described in detail later in this chap-
ter. When the records are exported, the appropriate picture for each Category
heading will be selected (as specified in the Category screen – see Chapter Two
for details). 
Don’t Print Headings

If you select this option, the display changes:

If this option is selected, the Category headings will not be printed at all when
the data is exported.

Table of Contents Entry
If you want to have each Category heading marked for building a Table of

Contents, check this box. This is option works only with exports to RTF docu-
ments. All Category headings at all three levels will be marked for inclusion in the
TOC.

Index Entry 
If you want to have each Category heading marked for inclusion in an index,

check this box. 
Note: This option requires the use of the Indextension Quark Xtension if you

are using QuarkXPress. 
All Category headings at all three levels will be marked for inclusion in the

index.

Click on the Paragraphs tab to return to the first page and set up the para-
graphs for your Export Style Sheet.
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Setting up Paragraphs
Each Export Style Sheet consists of one or more Paragraphs. Each Paragraph

consists of one or more Elements.
What goes into a Paragraph?

A Paragraph might consist of data from one field in the database (such as the
company or product name), or it might contain a number of different elements.
Consider the following paragraph of information from the Companies table:

Tel: 01920 871866 Fax: 01920 877917 Web: www.catbase.com

The paragraph includes data from three fields (phone, fax, and web site), but it
is made up  of eight elements:

1. The text, “Tel: ”
2. The phone number from the database
3. A Tab character
4. The text, “Fax: ”
5. The fax number from the database
6. A Tab character
7. The text, “Web: ”
8. The web site address from the database

Three different Element types are used:
Fields
Text
Punctuation (Tabs)

You build up Paragraphs by adding Elements like building blocks.

Creating Paragraphs
To create a new Paragraph, click on the Add Paragraph button on the

Paragraphs page of the Export Style Sheet. A new Paragraph screen appears:
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Paragraph Name
✏ Type a name for the paragraph. This is for reference only, so just give it a

descriptive name such as “Company name” or “Phone/Fax etc.”. Each
Paragraph MUST have a name. 

Style Sheet Name
Choose a Style Sheet from the Style Sheet Name pop-up menu. This pop-up

menu lists all the Paragraph Style Sheets you created. If you discover that you
need a new style sheet at this point, you can create one without leaving the
Export Style Sheet by clicking on the New Stylesheet button.

You will be able to apply different formatting to the Elements that comprise
the paragraph; however, each Paragraph must have a basic Style Sheet
specified. 

If you don’t choose a Style Sheet, the default (Normal) will be used. 

Paragraph No.
CatBase assigns the paragraph number; you can’t change it here. This is what

determines the order in which the Paragraphs will be exported. If you want to
change the order of the Paragraphs, you can do so by moving a Paragraph up or
down within the list of Paragraphs on the main Export Style Sheet screen screen.

Elements
Each Paragraph must have at least one Element (if it doesn’t, nothing will be

exported!). To create a new Element, click the Add an Element button. A new
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Element screen will open up:

The seven Element types are described next.

Field Element
When you create a new Element, the Field radio button is selected and the

first field in the current table is selected. (The current table is the table on which
the export is based, or a related table – see the explanation of Relation, below). 

If you want to use the first field of the current file, you can save the Element
without making any changes to the screen.

To use a different field, select the one you want from the pop-up list of fields.

Text Element 
When you click the Text radio button, the cursor is placed in the Text area

and you can type the text you want to publish. 
You can enter text of any amount (up to about 32,000 characters) into the Text

field. This is useful for including labels, descriptions, comments, and other text
data in your export. Here are some examples:

• Insert the word “Phone:” in front of a telephone number
• Create record-specific messages such as “We cannot ship Chocolate-

Covered Cherries during the summer months.” To accomplish this, you
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would create a Paragraph consisting of three elements. The first Element
would be a Text element like this:

You can’t see it in this illustration, but there is a space after the word “ship.”

The second element is a Formula like this:

➨ Notice that there is no entry in the second Export Text field. This
Formula will export the product name if the word “chocolate” is found in
the product name; otherwise, it will export nothing.

➢ In the Preferences page of the Element screen for this Element, check the
Omit Paragraph check box:
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➨ The third Element is another Text element:

➨ Notice the space in front of the word “during.”

When you export the data, for every chocolate product the shipping advisory
will be included. For non-chocolate products, the paragraph will be left out com-
pletely.

Formula Element
Formulas let you tell CatBase how to make intelligent decisions about what to

do with certain data according to the actual data in any record. All Formulas are
based on the construction: 

IF <some test> IS TRUE, THEN <export the contents of a field or some
text> OTHERWISE <export the contents of a field or some text>.

To create a Formula, click on the Formula button in a new Element screen. A
new Formula screen opens up:
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There are four general areas on this screen.

Formula Summary
At the top of the screen is the Formula Summary box. This box displays a sen-

tence summarising how the Formula will work. The Formula Summary for a com-
pleted Formula might look something like this:

It’s always a good idea to check the Formula Summary before saving a new
Formula.
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The “IF” area

This area lists the fields from the current table, and the set of radio buttons
next to the field list shows the various operators that are available:

The text of the radio buttons changes according to the type of the field select-
ed. 

Text 
If the field type is text, the buttons are labelled as shown above. The result of

each option is:

Contains
With Contains selected, you must enter some text into the Comparison area

to the right of the Operator buttons. When CatBase is exporting the data and this
Formula is reached, it will export the specified field or text IF the record being
exported contains the text you entered into the Comparison area. For an exam-
ple, see the Chocolate example above.

Starts with
Starts With works much like Contains, except that the field data must begin

with the text specified in the Comparison area for the IF portion of the formula to
be evaluated as TRUE.

Is Blank
If the Is Blank radio button is selected, the IF portion of the formula will evalu-

ate as TRUE if there is no data at all in the selected field. NOTE that a space does
count as a character! A field containing a space is NOT blank.
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Equals
For an Equals formula to evaluate as TRUE, the data in the selected field must

EXACTLY match the text that was entered into the Comparison area, except that
upper and lower case are not significant.  Here are some examples of how an
Equals formula will evaluate text:

Comparison text Field contents Result
nuts and bolts Nuts and bolts TRUE
nuts and bolts NUTS AND BOLTS TRUE
nuts and bolts Nuts FALSE
nuts and bolts More nuts and bolts FALSE
nuts and bolts Nuts & bolts FALSE

Is Not Blank
If there is any text at all (even just one space) in the selected field, the Is Not

Blank Formula will evaluate as TRUE.

Numeric field type
If the field type is numeric, the radio buttons are labelled like this:

Equals 
If the number in the selected field is exactly equal to the value that is specified

in the Comparison area, the Formula will evaluate as TRUE. 

Greater Than 

If the number in the selected field is greater than the value that is specified in
the Comparison area, the Formula will evaluate as TRUE. 

Greater Than or Equal To 
If the number in the selected field is greater than or equal to the value that is

specified in the Comparison area, the Formula will evaluate as TRUE. 

Less than 
If the number in the selected field is less than the value that is specified in the

Comparison area, the Formula will evaluate as TRUE. 

Less than or Equal To 
If the number in the selected field is less than or equal to the value that is
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specified in the Comparison area, the Formula will evaluate as TRUE. 

Not Equal to 
If the number in the selected field is not equal to the value that is specified in

the Comparison area, the Formula will evaluate as TRUE. 

Logical
If the field type is logical (Boolean), the operator radio buttons are labelled like

this:

True
If the field is TRUE, then the formula evaluates as TRUE. An example of a

boolean field is the Inactive field in the Company and Product  files. If a record
has been made Inactive, the Inactive check box on the data entry screen is
checked and the Inactive field is TRUE. 

False
If the field is FALSE, the formula evaluates as TRUE.

Date
If the field type is Date, the operator radio buttons look and function the same

as for a numeric field.

The THEN Area

This area determines what will happen if the IF area evaluates to True.
You can either export the data from a field, or some specific text.

Use Stylesheet
You can tell CatBase to use a stylesheet other than the default style sheet that

has been specified for the paragraph if a condition is True. Click in the Use
Stylesheet: check box to select it, and then pick the style sheet you want to use
from the pop-up list of style sheet names. For example:

Some companies have paid extra to have their product names listed in bold.
You have set up a default style sheet for the Product Name paragraph which uses
a plain font. You have kept track of which products should be in bold by making
the P3 field (a Boolean field) TRUE for such fields; for these, you want to use a
style sheet named NameBold. You would set up a Formula like this:
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Don’t forget that the Formula determines exactly what is exported as well as
how it is formatted, so you must select the Product Name field in both the THEN
and the OTHERWISE areas.

Note: the selected Style sheet will be applied to the entire paragraph, not just
this Element.

OTHERWISE Area
The OTHERWISE area determines what will happen if the IF area evaluates to

False:

It’s OK to leave this area unchanged. The effect will be “do nothing” if the
Formula evaluates to False.

When you have set up a Formula, the Formula Summary is displayed on the
Element screen

Punctuation Element Type
If you want to include a Tab, Return, Line Feed or Form Feed in an Export

Style Sheet, this is where you do it. If you are using XPress, you also have the
Indent Tabs option. The Form Feed character can be especially useful when you
want to start each new record on a new page or jump to the next linked text box
(QuarkXPress only). 

Calculation Element type
You can perform various calculations on numeric data as it is being exported,
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and get a running count of the number of records:

Only the numeric fields from the current file are listed in the field list. 
There are six summary calculations: Sum, Count Records, Average, Maximum,

Minimum, and Median. If you choose one of the summary calculations, the result
will be exported only with the FIRST record in the export. The calculations are
performed on all the records being exported except if the records are being
exported by Category, in which case  the calculation will be on all the records in
the Category.

Sum
Sum adds up the values in the selected field for all the records being export-

ed.
Count Records
Counts the number of records being exported.
Average
Averages the values in the selected field.
Maximum
Finds the highest value for the selected field.
Minimum
Finds the lowest value for the selected field.
Median
Finds the median value for the selected field.

Discount
Discount can be useful if you want to discount all prices by a certain percent-

age, for example, to produce a special sale catalogue. When you export the data,
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the value in the selected field will be discounted by the percentage you specified. 

Markup
Markup works just like Discount, except that the value in the field is increased

by the specified percentage instead of being decreased. 

Record Number
You can get a running record number by selecting the Record Number radio

button. When the records are being exported from CatBase, if you have a Record
Number calculation set up, CatBase will include each record’s order in the cur-
rent export. This number has nothing to do with the record’s product number or
any data that is stored in the record; it depends entirely upon how the records are
sorted at the time they are exported. You can change the starting number to any
integer. This will be useful if you are building your publication in sections, for
example, if you are doing each category separately. You would export the records
for the first category, look at the file to find out what the last number was, and
enter that number plus one as the starting number for the next category.

Number Format
You can choose the format of the resulting calculation by clicking on the

Number Format button on the Preferences page for the Element.
After you have completed a Calculation, a description of it is displayed on the

Element screen:

Picture Element
This option works only with QuarkXPress, HTML, and PageMaker V. 6.5 or

later. For use with QuarkXPress, the XTags Xtension is required. If you set up a
Picture Element and then use the Export Style Sheet for exporting to a destina-
tion that does not support pictures, the element will just be ignored.

For information about what is required to export pictures to the various sup-
ported destinations, please see the detailed discussion at the beginning of
Chapter Three, Data Entry.

Setting up placement of pictures requires two steps in CatBase:
1. In the Company or Product record to which the picture belongs, you must

enter the picture’s name and location.
2. In the Export Style Sheet, you must set up a Picture Element.

Picture Specs
You can set up an individual picture box specification for each record, or glob-

ally for all pictures in an export. You set up a Picture Specification for an individ-
ual record by clicking on the Picture Specs button on either the Company or
Product record’s picture screen, and you set up a global picture specification in
the Element screen. 

If you have both individual and global picture specifications, you need to
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make sure CatBase knows which specification should have priority. This is done
on the Setup page:

If the Export Style Sheet radio button is selected, CatBase will ignore the pic-
ture specification that was set up in the record and use the global specification. If
the Record radio button is selected, CatBase will use each record’s individual pic-
ture specification if one has been set up, otherwise it will use the global specifi-
cation that was set up in the Picture Element. To change this setting, choose
Setup from the Admin menu.

When you click on the Picture Specs button or the Picture radio button in the
Element screen, this dialogue box appears:

HTML: If you are exporting data to an HTML document, most of these specifi-
cations will be ignored as the size and location of the pictures depend upon your
web browser. 

Quark XPress: The choices available in this dialogue are all explained in your
XPress manuals, except for the two sets of radio buttons at the bottom:
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If Picture Name is Missing
Perhaps only some of your records have associated pictures. In that case, you

don’t want to have an empty picture box drawn in your XPress document. Leave
the Don’t draw box radio button selected.

On the other hand, perhaps there is supposed to be a picture for each record.
In that case, you would probably want to have the picture box drawn if the pic-
ture name was missing. This would make sure that the space was allocated in the
publication for the picture. A quick scan of the layout would quickly tell you if any
pictures were missing from their boxes. If there is supposed to be a picture for
every record, select the Draw box radio button.

Anchored/Unanchored Picture Box
Note: this option applies only if you are using QuarkXPress. For PageMaker

Version 6.5 or later, all pictures are anchored (in-line).
Like text boxes, picture boxes can either be anchored or unanchored. An

anchored picture box will always “stick” with its text, so that if the layout
changes and the text re-flows, the pictures will remain in the correct relative posi-
tion. An unanchored picture box, on the other hand, will stay on the page where it
landed when the data was imported into the layout, unless you move it manually.

A few pointers for successful picture placement:
1. Make sure that you get the pathnames exactly right
2. If using QuarkXPress, make sure that your document has been saved

before you try to import a CatBase export file that contains picture specifications.
If you create a new XPress document and try to import a file without first saving
the document, the pictures might not be found.

3. Anchored (in-line) pictures must be NO WIDER than the column into which
they are going! We recommend that they are slightly narrower than the column.

Relation Element
Relations make it possible for you to peek into tables related to the table on

which the Export Style Sheet is based, and grab data from them for inclusion in
your export. 

For example, you may wish to list information about a particular company,
show all of each company’s products and then provide detailed information
about each product. CatBase allows you to link all of that information in a very
straightforward manner.

All relations work in this manner: There are two types of tables — a “one”
table and a “many” table. The “one” table is the table to which one or more
records in the “many” table are related. For example, you might have only one
“Smith Company” in the Companies table but you could have many products
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from the Smith Company in the Products table. Thus, the Companies table is the
One table and the Products table is the Many table. If you prefer, you can think of
the relationship as a parent-child relationship: the “one” table is the parent, and it
can have any number of “child” records related to it.

The possible Relations in CatBase are:

“One” table “Many” table
Companies Products
Companies Contacts
Products Product Details
Companies Categories
Products Categories

When you open a new Element screen, the Relation area looks like this:

➢ To create a Relation, click on the Relation radio button.
➢ Click on the Relations button to choose the relation you want:
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The choices of Relation Types depend upon the table on which the Export
Style Sheet is based. In the example shown here, the Export Style Sheet is based
on Companies, and so there are three Relation Types from which to choose. 

➢ Click on the radio button appropriate to the relation you want to use, and
then click on the Element tab at the top of the screen to go back to the
main screen for the Element.

➢ Click on the Element tab to go back to the first Element page.

Sort Field
Notice that a field has been selected in the Sort Field: pop-up list. If you want

to sort the related records on a different field, click on the pop-up list and choose
the field you want. For example, if you create a relation from the Companies table
to the Company Contacts table, the default Sort Field is Last Name. But you
might want to sort the Contacts by Title or Sort Order. 

When you create a Relation, you effectively create a new level of Export Style
Sheet specification. You’ll set up a second-level hierarchy of Paragraphs and
Elements, with the current table now being the table to which the relation was
made. This relation tells CatBase where to look for the additional information you
have specified.

The hierarchy could be represented like this:

Export Style Sheet, based on the Companies table
Paragraph One

Element One: Field: Company Name
Paragraph Two

Element One: Relation to the Products table
Paragraph One

Element One: Product Name
Element Two: Tab character
Element Three: Price

Paragraph Two
Element One: Description

Suppose you were designing an Export Style Sheet to produce a product cat-
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alogue, and you wanted to include telephone and address information for the
company supplying each product. This is what you would do:

➢ Create a new Paragraph.
➢ Create a new Element.
➢ Click on the Relation radio button.
➢ Click on the Relations button to choose the relation you need.
➢ Click the Add Para’ button to add a new Paragraph.

A new Paragraph screen opens up:

This, as you can see, is very similar to the Paragraph screens that you have
already seen, and it works in exactly the same way. 

When you have set up a few Paragraphs for a Relation, the Relation area
might look like this:
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Changing the order of Paragraphs
To change the order of the paragraphs, simply click on the line you want to

move, drag it up or down in the list, and drop it on top of the line that you want it
to go ahead of.

To delete a paragraph:
➢ Click once on the paragraph you want to delete.
➢ Click on the Delete Para` button.
CatBase will ask you to confirm that you want to delete the selected para-

graph, and will go ahead and delete it if you confirm that you do want to.
An excellent example of the use of Relations is the Four-Table Example in the

Demo database. 

Element Preferences
Click on the Preferences tab on the Element screen to go to the Preferences

page:
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Data Formatting

Text Format
This option is not available if the Element is a Relation.
As you know, you must select a Style Sheet for each Paragraph; this contains

the formatting instructions such as the font, size, style, etc. for the entire para-
graph. However, you might want to format one Element within the paragraph dif-
ferently; you may want to print a discount price in red, or in italics, or whatever.
You can achieve this by clicking on the Text Format button, in which case
you’ll see the following screen:
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The options on this screen are similar to those found on the Style Sheet
screen, and are described in more detail earlier in this chapter.

If you want to remove a text format, click on the Clear Formatting button.
Click on the OK button to save your format.

Number Format

Click on the Number Format button to specify the formatting of numeric
fields.

Note that we have used a £ sign for the currency symbol; you can change it to
a $ sign or whatever in the Setup screen.

Date Format
Click on the Date Format pop-up menu to select a format for a date field:
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Options

Omit Paragraph if this Element is blank
If this option is selected, the entire paragraph that contains this Element will

be left out of the export if this particular Element is blank. As an example of how
useful this can be, consider this common dilemma:

You are exporting data which includes company address information. You
want to have the phone number on one line, the fax number on the next line, and
the company’s email address on the next line. But if a company doesn’t have a
fax number, you don’t want a blank line appearing. To handle this, you would
select the Omit Paragraph option for the Element that contained the Fax field.
Consequently, if a company’s fax number field was filled you would get some-
thing like this:

Tel: 01920 871866
Fax: 01920 877917
Email: info@catbase.com

and if a company had no fax number, you’d get:

Tel: 01920 871866
Email: info@catbase.com

Index this Element
Select this option to index the data from this Element. This option works only

with QuarkXPress, RTF, PageMaker, and HTML.
You should select only ONE index for each Export Style Sheet.
See Chapter Nine, Exporting Data, for more information about building index-

es.

Table of Contents Entry
This option works only with RTF documents. It inserts TOC tags into the text.

To create the Table of Contents, you choose a menu selection after importing the
data into the application (please check your application's documentation for
more details). If you have selected this option, and you export to a publishing
destination that does not support TOCs, it will be ignored when the data is
exported.
Unique Group Entry

This option tells CatBase to include repeated information only once. If this
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option is selected, then whatever is in the field that the Element belongs to will
only be exported once for each occurrence. This lets you do things like sort
entries by country and have the country name appear once at the beginning of
each group of entries.

In order for this to work properly, there are a couple of rules that must be fol-
lowed:

1. You can only have one Unique Group Entry for each Export Style Sheet.
2. The export MUST be sorted FIRST on the Unique Group field, and then on

whatever other field you want to sort on. For example, to sort Company
records by country, with the country name appearing once at the begin-
ning of each group of records in that country, and then having each coun-
try’s companies sorted alphabetically, you would sort on Country and
Company Name.

For an example of how this works, please see the Company Info by Country
example in the Demo database.

Creating Export Style Sheets: An Example
To illustrate how Export Style Sheets are created, we will work through the

process step-by-step. If you want to follow along with this example, we suggest
that you use the Demo Database to practice and experiment on.
The Project:

We want to produce a simple list showing each Company in the database,
sorted alphabetically, and under each Company name we want to show their
phone and fax numbers followed by a list of their products. It will look something
like this:

Company Name
Tel: 01234 567 8900   Fax: 01234 999 9999

Product A £50.00
Product B £123.78
etc.

There are basically three paragraphs of information:
1. The Company name
2. The company telephone and fax numbers
3. The list of products

The third paragraph – list of products – might actually consist of any number
of lines, but from the Export Style Sheet’s point of view, it is just the same para-
graph repeated over and over.

Each Paragraph can further be broken down into one or more Elements, as
follows:

1. Company Name
1.1 The field: Company Name
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2. Phone and Fax numbers:
2.1 The text: “Tel: ”
2.2 The field: phone number
2.3 Punctuation: a Tab character
2.4 The text: “Fax: ”
2.5 The field: Fax number

3. Product Name list
3.1 A Relation to the Products table

3.1.1 Paragraph: Product info
3.1.1.1 The field: Product name
3.1.1.2 Punctuation: a Tab character
3.1.1.3 The field: Price

There is one potential trap here: What if a company doesn’t have a Fax num-
ber? You don’t want to end up with a paragraph that looks like this:

Tel:  01234 123 4567 Fax:

To handle this eventuality, we will change the fourth Element in the Phone and
Fax Numbers paragraph from a Text Element to a Formula Element. Instead of
simply putting in the word “Fax:”, we will ask CatBase to make an intelligent
decision about whether to include that text or not, depending upon whether there
is an entry in the Fax field for each Company.

OK, let’s do it ...

➢ At the main CatBase screen, choose Export Style Sheets from the
Data menu and click on New Record when the Search Dialogue
Window appears.

You will then see the following window:
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CatBase needs to know which table to base the Export Style Sheet on, so that
it can display the correct selection of fields. Our project is going to be sorted pri-
marily by Company Name, which obviously comes from the Companies table.
The appropriate radio button is already selected.

➢ Click on OK.
A new Export Style Sheet window opens.

✏ Type “Example Export” into the Export Style Sheet Name field and press
the tab key on your keyboard.

✏ If you like, type a comment into the Description field.
➢ Press the Tab key again.
Near the bottom of the window there’s a pop-up list of the various publishing

destinations. If you are using the Demo database, XPress 3.x is selected. 
➢ If you are not using QuarkXPress, select an appropriate option from the

pop-up.
➢ Click on the Preferences 1 tab at the top of the window.
For now, we are only concerned about the Sort Order on this page:

We want to sort the records primarily by Company Name.
➢ Click on the Sort Order Pop-up and select Co Name (if you are using the

Demo Database), or click on the New Sort button and create a new Sort,
sorting by Company Name (creating Sorts is described in Chapter Four).

➢ If you have selected HTML as your publishing destination for this Export
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Style Sheet, click on the Preferences 2 tab and set up the HTML
Preferences (described in detail earlier in this chapter).

➢ Click on the Paragraphs tab to go back to the first page.
Now we are ready to add some Paragraphs.
➢ Click on the Add a Paragraph button. A new Paragraph window

appears:

✏ Type “Company name” into the Paragraph Name field.
How do you want the Company Names formatted? 
➢ Click on the Style Sheet Name pop-up and select a style sheet (for exam-

ple, CompanyName in the Demo database). If you don;t see a style sheet
you want to use, you can create a new one by clicking on the New
Stylesheet button (style sheets are described in detail at the beginning
of this chapter).

Now we need to tell CatBase what goes into this Paragraph.
➢ Click on the Add an Element button. A new Element window appears:
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We want to publish each company’s name, and that is stored in the Company
Name field.

➢ Click on the pop-up field list next to the Field radio button, and select the
field Company Name.

The Field area should look like this:

Note: If you are not using the Demo database, your list of field names might
be different. Select the appropriate field name.

➢ Click on the Save button ( ) to close the Element.

The Paragraph window now shows that you have added one Element to
this Paragraph:

➢ Click on the Save button again to go back to the Export Style Sheet win-
dow, which should now show that you have added a Paragraph:
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➢ Click on the Add a Paragraph button to add a second Paragraph.
✏ Name this paragraph “Phone and Fax”.
➢ Select a suitable Style Sheet for this paragraph (in the Demo database,

choose “Details”).
➢ Click on the Add an Element button.
Remember that we want this paragraph to contain the following information:

Tel: nnn nnnnn Fax: nnnn nnnnnn

The first element is the text, “Tel:”

➢ Select the Text radio button.
✏ Type “Tel: ” into the field next to the Text radio button, not forgetting to

include a space after the colon. The Text area should look like this:

➢ Click on the Save button.
➢ Add another Element.
➢ Select the field, Phone, and save the Element.
➢ Add another Element.
➢ Select the Punctuation radio button. Tab is selected by default, and

that’s what we want, so Save the Element.
➢ Add another Element.
This is where we want to put the word “Fax:”, but not if there isn’t a fax num-

ber. So instead of making this another Text Element, we’ll create a Formula.
➢ Select the Formula radio button.
The Formula window opens:
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What we want to tell CatBase is:

If there’s a fax number, then print the word “Fax:”, otherwise, don’t print it.

➢ Scroll down in the list of fields and select Fax.
➢ Select the Is Not Blank radio button.
✏ In the THEN area, type “Fax: ” into the field next to Export Text: (not for-

getting the space after the colon).
The Formula should now look like this:
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➢ Save the Formula.
➢ Save the Element.
➢ Add another Element.
➢ Select the field, Fax.
➢ Save the Element.
The Paragraph window should now show a list of the five Elements that com-

prise this Paragraph:

➢ Save the Paragraph.
There should now be two Paragraphs in the list: Company Name and Fax and

Phone.
➢ Add a new Paragraph.
✏ Name the new paragraph Product List.
➢ Add an Element.
So far we have used fields from the Companies table, but now we want to

make a list of each Company’s products, and that information is stored in a dif-
ferent table: the Products table. We need to tell CatBase that we want to grab the
data from another table.
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➢ Select the Relation radio button.
➢ Click on the Relations button or on the Preferences tab.
You’ll see the Preferences page:

In the Relation Types area there is a list of all possible relations. The relation
we want is between Companies and Products, and that is what has been select-
ed by default, so we don’t need to change anything this time.

➢ Click on the Element tab to go back to the first page.
Now we need to tell CatBase what information we want to get from the

Products table, and how to sort it.
➢ Make sure that Product Name is selected in the Sort Field popup:

➢ Click on the Add Para’ button in the Relation area.
The now-familiar Paragraphs window opens. The window title reads

Paragraphs 2 for Example Export to remind you that you have gone into a
deeper level of Paragraphs.

➢ Name this Paragraph Name & Price.
➢ Select an appropriate style sheet for this Paragraph e.g., in the Demo

database, you could choose Details.
➢ Click on the Add an Element button.
➢ Choose the field Product Name from the pop-up field list.
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➢ Save the Element.
➢ Add another Element.
➢ Select the Punctuation radio button.
➢ Save the Element.
➢ Add another Element.
➢ Select the field, Price Numeric.
We want to make sure that the prices are formatted correctly.
➢ Click on the Preferences tab.
➢ Click on the Number Format button.
The Number Format window opens:

The appropriate format is selected by default, so that’s OK.
➢ Click on OK.
➢ Save the Element.
The Paragraph should now contain three Elements:

➢ Save the Paragraph.
➢ Save the Relation Element.
➢ Save the Product List paragraph.
➢ Save the Export Style Sheet.
Now let’s try it out …
➢ Choose Companies … from the Data menu and click on All Records, or

create a list of some Company records.
➢ Choose Export … from the File menu.
The Export Dialogue appears:
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This dialogue shows a list of all Export Style Sheets that have been set up
based on the Companies table. Our new one, Example Export, is there.

➢ Select Example Export.
➢ Click on OK.
CatBase asks you what to name the export file, and where to save it. Change

the name from the default, if you wish, and make sure it is going to be saved  into
a suitable place (e.g., your CatBase folder).

➢ Click on Save.
CatBase creates a file that contains the data plus all the formatting instruc-

tions. When it has finished exporting the data, open up the file using the appro-
priate publishing program (please refer to Chapter Nine for detailed information
about working with various publishing destinations).

For example, here is the result in a QuarkXPress document:

EXPORT STYLE SHEETS

V. 4.17 7.63



Now you know how to create Export Style Sheets!

If you are still not sure how to achieve a particular result, please contact us –
we will be only too pleased to help. Ideally, send us an example of how you want
your publication to look. You can send an email to support@catbase.com or con-
tact us by fax or telephone.
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Duplicating Export Style Sheets
It can sometimes be useful to make one or more exact duplicates of an Export

Style Sheet — for example, you might need to create an Export Style Sheet that
is a variation on one that already exists. It will probably be easier to duplicate the
existing one and make the necessary changes in the duplicate than to create a
new one from scratch.

➢ Choose Export Style Sheets … from the Data menu and find the one or
ones you want to duplicate.

➢ In the list of Export Style Sheets, press Command-A to select all, or select
just the ones you want to duplicate.

➢ Choose Duplicate from the Modify menu.
✏ Enter the number of duplicates you want (maximum of 99)
➢ Click on OK.
The Export Style Sheets are duplicated.

Export Style Sheet Reference
You can print out a reference to your Export Style Sheets. This shows detailed

information such as the Paragraphs and Elements that comprise the Export Style
Sheet and their formatting.

➢ Choose Export Style Sheets … from the Data menu and find the one or
ones for which you want to print out a reference.

➢ In the list of Export Style Sheets, press Command-A to select all, or select
just the ones you want to print out.

➢ Choose Print Reference from the File menu.
Click on OK at the print dialogue box to print the references.

When you have created an Export Style Sheet, you should test it by exporting
some data and placing it into your page layout program. This procedure is
explained in Chapter 8, Exporting Data.

A good way to get some ideas on creating Export Style Sheets is to look at
some that have been set up in the Demo Data File.

Exporting and Importing Export Style Sheets
If you have more than one CatBase data file, you might want to transfer an

Export Style Sheet from one data file to another. You can easily do this by export-
ing the Export Style Sheet from the data file in which it has been designed, and
then importing it into another data file. Here’s how to do it:

➢ At the main CatBase screen, choose Export Style Sheets … from the Data
menu and find the Export Style Sheet or Sheets you want to transfer.

➢ With the list displayed on your screen, choose Export … from the File
menu.

✏ Enter a name for the text file that CatBase will create.
➢ Click on the Save button.
CatBase creates a text file containing the Export Style Sheet setup informa-

tion. When it is finished:
➢ Click on the Done button to return to the main screen.
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Quit and open the other data file.
➢ Choose Export Style Sheets … from the Data menu.
➢ At the Search Dialogue, click on the Import button.
➢ Locate the text file you just created from the original data file and double-

click on it.
The Export Style Sheet or Sheets are imported into the data file.
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